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Opmerking
Tijdens het maken van dit hoofdstuk werd de pictogrammenset Klein – Tango gebruikt. 
De pictogrammen kunnen eenvoudig aangepast worden via Extra > Opties... > 
LibreOffice > Weergave en dan uw keuze maken bij Pictogramgrootte en stijl.

Opmerking voor gebruikers van Mac

Sommige toetsaanslagen en menu-items zijn anders op een Mac dan in Windows en Linux. De 
tabel hieronder geeft enkele algemene vervangingen voor de instructies in dit hoofdstuk. Voor een 
meer gedetailleerde lijst, bekijk de Help van deze toepassing.

Windows/Linux Equivalent voor Mac Effect

Menuselectie Extra >
Opties

LibreOffice > Voorkeuren Toegang tot instellingsopties

Klik met rechts
Control+klik of met rechts 
klikken, afhankelijk van de 
computerinstellingen

Contextmenu openen

Ctrl (Control)  (Command)⌘ Gebruikt met andere toetsen

F5 Shift+⌘+F5 De Navigator openen

F11 ⌘+T Het venster Stijlen en opmaak openen
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Wat is Draw?

LibreOffice Draw is een tekenprogramma voor vectorafbeeldingen, hoewel het ook enkele 
bewerkingen op rasterafbeeldingen (pixels) kan uitvoeren. Door Draw te gebruiken kunt u snel een
groot scala aan grafische afbeeldingen maken.

Vectorafbeeldingen slaan afbeeldingen op en geven deze weer, als samenstelling van eenvoudige 
geometrische elementen zoals lijnen, cirkels en veelhoeken in plaats van een verzameling pixels 
(punten op het scherm). Vectorafbeeldingen maken eenvoudige opslag en het op een andere 
schaal weergeven mogelijk.

Draw is volledig in het kantoorpakket LibreOffice geïntegreerd en dit vereenvoudigt het uitwisselen 
van afbeeldingen tussen alle componenten van het pakket. Als u bijvoorbeeld een afbeelding 
maakt in Draw, is het opnieuw gebruiken daarvan in een Writer-document net zo eenvoudig als het
kopiëren en plakken van die afbeelding. U kunt ook rechtstreeks met afbeeldingen werken in 
Writer en Impress, waarbij u een deel van de functies en gereedschappen van Draw kunt 
gebruiken.

De functionaliteit van Draw is uitgebreid; hoewel het niet werd ontworpen om te concurreren met 
andere uitmuntende grafische toepassingen, bezit Draw toch meer functies dan de meeste 
tekenprogramma's die in kantoorpakketten geïntegreerd zijn.

Een aantal voorbeelden van tekenfuncties zijn: Lagenbeheer, Magnetisch systeem van 
rasterpunten, Weergave van dimensies en maateenheden, Verbindingen voor het maken van 
organogrammen, 3D-functies die het mogelijk maken kleine driedimensionale tekeningen te maken
(met textuur- en belichtingseffecten), Integratie van tekenobject- en paginaopmaakprofielen, 
Bézier-bogen.

Dit hoofdstuk introduceert een aantal functies van Draw, maar niet alle functies worden besproken.
Bekijk de Handleiding voor Draw en de Help-functie voor meer informatie.

Het hoofdvenster van Draw

De belangrijkste componenten van de werkruimte van Draw worden getoond in Afbeelding 1:

• Menubalk

• Werkbalk Standaard

• Paginavenster

• Werkruimte

• Statusbalk

• Lagenbalk

• Werkbalk Tekening

• Zijbalk

Werkruimte
Het grote gebied in het midden van het venster (Werkruimte) is waar u uw tekeningen maakt en dit
tekengebied kan door werkbalken en informatiegebieden omringd worden. Het aantal en de positie
van de zichtbare werkbalken wisselt, afhankelijk van de te volbrengen taak en de 
gebruikersvoorkeuren, daardoor kan uw weergave er anders uit zien dan in Afbeelding 1  .

De maximale afmeting van een afbeelding in LibreOffice Draw is 300 cm bij 300 cm.
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Deelvenster pagina’s
U kunt tekeningen in Draw over meerder pagina’s opsplitsen. Multi-pagina-tekeningen worden 
vooral voor presentaties gebruikt. Het deelvenster Pagina’s geeft een overzicht van de pagina’s die
u voor uw tekening gemaakt heeft. Als het deelvenster Pagina’s niet zichtbaar is, ga dan naar 
Beeld op de Menubalk en selecteer Deelvenster Pagina. Om wijzigingen inde paginavolgorde 
aan te brengen, sleept u één of meerdere pagina’s naar een andere positie en zet ze neer.

1 Menubalk 4 Deelvenster Pagina’s 7 Werkbalk Tekening

2 Werkbalk Standaard 5 Werkruimte 8 Lagenbalk

3 Zijbalk 6 Statusbalk

Afbeelding 1: Werkruimte van Draw

Lagenbalk
Een laag is een werkruimte waarin u tekenelementen en objecten kunt invoegen. De Lagenbalk is 
aan de onderzijde van de werkruimte geplaatst en bevat geleiders voor het selecteren van lagen 
en en opdrachten voor lagen. Voor meer informatie over lagen, zie Werken met lagen op pagina
11.

Zijbalk
De Zijbalk heeft vier panelen. Om een paneel, dat u wilt gebruiken, naar voren te halen, klik op het 
betreffende pictogram of klik op het kleine driehoekje boven de pictogrammen en kies het 
gewenste paneel uit de keuzelijst. Er kan slechts één paneel tegelijk geopend worden. Als de 
Zijbalk niet zichtbaar is, ga naar Beeld op de Menubalk en selecteer Zijbalk in de lijst.
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Eigenschappen 

Opent gedeeltes voor objecteigenschappen, die u naar uw wensen kunt aanpassen. De 
gedeeltes zijn: Voeg een vorm in, Teken, Alinea, Afbeelding, Lijn en Positie en Grootte.

Stijlen en opmaak 

Hier kunt u afbeeldings-opmaakprofielen aanpassen en toepassen op objecten in uw tekening. 
Als u een opmaakprofiel aanpast, worden de wijzigingen automatisch toegepast op alle 
elementen in uw tekening, die met dat profiel zijn opgemaakt.

Galerij 

Opent de Galerij met tekeningen, waar u een object in uw tekening kunt invoegen, zowel een 
kopie als een koppeling. Een kopie van een object is onafhankelijk van het oorspronkelijke 
object. Wijzigingen aan het oorspronkelijke object hebben geen invloed op de kopie. Een 
koppeling blijft afhankelijk van het oorspronkelijke object. Wijzigingen aan het oorspronkelijke 
object beïnvloeden ook het gekoppelde object.

Navigator 

Opent de Navigator in Draw, waar u snel tussen de pagina's van uw tekening kunt wisselen of 
een object van een tekening kunt selecteren. Het is aan te bevelen om pagina's en objecten in 
uw tekening betekenisvolle namen te geven, zodat u ze in de Navigator gemakkelijk kunt 
vinden.

Linialen
U zou linialen (balken met nummers) aan de boven- en linkerkant van de werkruimte moeten zien. 
Als ze niet zichtbaar zijn, kunt u ze aanzetten door Beeld > Linialen op de Menubalk aan te 
vinken. De linialen geven de grootte van een, op de pagina geselecteerd, object met grijze dubbele
lijntjes weer (zoals in Afbeelding 2 gemarkeerd). Wanneer er geen object geselecteerd is, tonen ze
de locatie van de muisaanwijzer; dit helpt bij het meer nauwkeurig plaatsen van de tekenobjecten.

U kunt de linialen ook gebruiken om object-handvatten en hulplijnen te beheren, waardoor het 
gemakkelijker wordt om objecten te plaatsen.

De pagina-marges in het tekengebied worden ook op de linialen weergegeven. U kunt de marges 
rechtstreeks op de linialen wijzigen door deze met de muis te verslepen. De marges worden 
aangegeven door grijze gebieden op de linialen, zoals in Afbeelding 2 is te zien.

Afbeelding 2: Linialen die de afmetingen 
van een geselecteerd object weergeven
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Klik met rechts op één van de linialen en selecteer één van de maateenheden uit de keuzelijst (zie
Afbeelding 3) om de maateenheid van de linialen te wijzigen. De twee linialen kunnen 
verschillende eenheden hebben.

Afbeelding 3: Maateenheden liniaal

Statusbalk
De Statusbalk bevindt zich aan de onderzijde van de werkruimte (zoals in alle componenten van 
LibreOffice); het bevat verscheidene velden die specifiek voor Draw zijn. Voor details over de 
inhoud en het gebruik van deze velden, Zie Hoofdstuk 1, Kennismaken met LibreOffice in dit 
handboek en Hoofdstuk1, Starten met Draw, in de Handleiding voor draw.

1 Informatiegebied 4 Niet opgeslagen wijzigingen 7 Zoomschuifbalk

2 Positie 5 Digitale handtekening 8 Zoompercentage

3 Afmetingen object 6 Dianummer

Afbeelding 4: Statusbalk in Draw

Opmerking
De groottes worden in de huidige maateenheid gegeven (niet te verwarren met de 
eenheden op de linialen). De maateenheid van de Statusbalk wordt gedefinieerd in 
Extra > Opties > LibreOffice Draw > Algemeen, waar u ook de schaling van de 
pagina kunt wijzigen.

Werkbalken
Om de verschillende werkbalken van Draw weer te geven of te verbergen, ga naar Beeld > 
Werkbalken. U kunt, uit het menu dat verschijnt, kiezen welke werkbalken u wilt tonen. Voor meer 
over het werken met werkbalken, zie hoofdstuk 1 Kennismaken met LibreOffice in dit boek.

De gereedschappen die beschikbaar zijn op de werkbalken van Draw worden in de volgende 
gedeelten nader uitgelegd. Het uiterlijk van de pictogrammen op de werkbalken kan variëren, 
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afhankelijk van uw besturingssysteem en de keuze van de grootte en stijl van de pictogrammen in 
Extra > Opties > LibreOffice > Weergave.

Werkbalk Standaard
De werkbalk Standaard is voor alle componenten van LibreOffice dezelfde en wordt in dit 
hoofdstuk niet beschreven. Standaard is deze direct onder de Menubalk geplaatst.

Werkbalk Tekening
De werkbalk Tekening is de belangrijkste werkbalk in Draw. Hij bevat alle nodige functies voor het 
tekenen van verschillende geometrische en vrije hand-vormen en ook om ze op de pagina te 
schikken. Standaard is deze verticaal vastgezet aan de linker zijde van het venster van Draw.

Werkbalk Lijn en opvulstijl
Met de werkbalk Lijn en opvulstijl kunt u de belangrijkste eigenschappen van een tekenobject 
wijzigen. De pictogrammen en submenu's variëren afhankelijk van het type object, dat  
geselecteerd is. Bijvoorbeeld, om de opmaak van een lijn te veranderen, klik op het pictogram van 
de pijlstijl en kies de gewenste stijl.

De functies op deze werkbalk zijn ook beschikbaar op het paneel Eigenschappen van de Zijbalk, 
als een tekenobject geselecteerd is. Standaard wordt de werkbalk Lijn en opvulstijl niet 
weergegeven, maar kan zichtbaar worden gemaakt via het menu Beeld > Werkbalken.

Werkbalk Tekstopmaak
Als het geselecteerde object tekst bevat, geeft de Zijbalk relevante informatie weer in het paneel 
Eigenschappen. Standaard wordt werkbalk Tekstopmaak niet weergegeven, maar kan zichtbaar 
worden gemaakt via het menu Beeld > Werkbalken. Als u zowel de werkbalk Lijn en opvulstijl als 
de werkbalk Tekstopmaak aangezet heeft, schakelt Draw tussen de twee werkbalken, afhankelijk 
van het geselecteerde object.

Werkbalk Opties
Met de werkbalk Opties kunt u verschillende vormen van hulp bij het tekenen in- of uitschakelen. 
Standaard wordt de werkbalk Opties niet weergegeven, maar kan zichtbaar worden gemaakt via 
het menu Beeld > Werkbalken.

Werken met lagen

Gebruik lagen om een complexe tekening te maken door het stapelen van eenvoudigere 
tekeningen in elke laag. Het gebied van een laag die geen tekening bevat is transparant. U kunt 
elk aantal lagen aan een tekendocument toevoegen. Een laag kan zichtbaar zijn of verborgen 
worden, het kan afdrukbaar zijn of niet. Lagen zijn gemeenschappelijk voor alle pagina's van de 
tekening. 

Een tekendocument bevat standaard drie lagen die niet verwijderd of hernoemd kunnen worden. 
Hier zijn algemene manieren om ze te gebruiken:

• Lay-out: Hier kunt u de titel, de tekst en plaatsaanduiders voor objecten in plaatse.

• Besturingselementen: Deze laag staat altijd boven alle andere lagen. Hierin stopt u 
knoppen en andere besturingselementen van uw tekening.

• Maatlijnen: Hierin plaats u, indien relevant, de maatlijnen van uw object.

Voor meer informatie over lagen, zie Hoofdstuk 11, Gevorderde tekentechnieken, in de 
Handleiding voor Draw.
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Een laag toevoegen
Om een laag aan uw tekening toe te voegen, selecteert u Invoegen > Laag op de Menubalk of 
klikt u met rechts of een tab in de Lagenbalk aan de onderkant van de Werkruimte (Afbeelding 1) 
en kiest u Laag invoegen. Het dialoogvenster Laag invoegen opent (Afbeelding 5).

Voeg de naam, de titel en de omschrijving van de laag toe. Selecteer, indien gewenst, of u het wilt 
kunnen afdrukken of het zichtbaar of verborgen moet zijn en of het geblokkeerd moet zijn om 
toekomstige wijzigingen of onbedoelde bewerkingen te voorkomen.

Een verborgen laag wordt wel getoond in de Lagenbalk, maar de naam is blauw. U kunt lagen in 
de Lagenbalk niet herschikken.

Opmerking
Lagen bepalen niet de volgorde van objecten in de stapel, behalve de laag 
Besturingselementen die altijd bovenaan staat. De stapelvolgorde van de objecten 
wordt bepaald door de volgorde waarin u de objecten toevoegt. U kunt de 
stapelvolgorde schikken met Wijzigen > Schikken.

Afbeelding 5: Dialoogvenster Laag invoegen

Kleuren kiezen en definiëren

Gebruik Beeld > Werkbalken > Kleurenbalk om het huidige kleurenpalet (Afbeelding 6) weer te 
geven. Standaard wordt de Kleurenbalk onder de werkruimte weergegeven. U kunt deze 
verbergen of weergeven door op de knop Verbergen/Weergeven te klikken. Hier kunt u snel de 
kleur kiezen voor objecten in uw tekening (lijnen, gebieden en 3D effecten). Het eerste vakje 
correspondeert met Geen (geen kleur).
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Afbeelding 6: Dialoogvenster Kleuren

U hebt toegang tot verschillende gespecialiseerde kleurenpaletten in Draw en ook de mogelijkheid 
om individuele kleuren naar eigen smaak te definiëren. Dit kan door Opmaak > Vlak op de 

Menubalk te kiezen of het pictogram Vlak  op de Zijbalk te klikken en dan het tabblad Kleuren 
te kiezen (Afbeelding 7).

Klik op het pictogram Lijst met kleuren laden  om een ander palet te laden. Het 
dialoogvenster voor bestandsselectie vraagt u om één van de standaard paletten van LibreOffice 
te kiezen (bestanden met de extensie *.soc). Bijvoorbeeld, web.soc is een kleurenpalet dat is 
aangepast aan het maken van tekeningen voor webpagina's. Deze kleuren zullen juist worden 
weergegeven op werkstations met beeldschermen die tenminste 256 kleuren kunnen weergeven.

Afbeelding 7: Dialoogvenster Gebied, tabblad Kleuren

In het keuzevak voor de kleuren kunt u elke kleur afzonderlijk wijzigen door de numerieke waarden
aan te passen in de velden aan de rechterkant van het kleurenpalet. U kunt de kleurenschema's 
bekend als CMYK (cyaan, magenta, geel, zwart) en RGB (rood, groen, blauw) gebruiken.
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Klik op de knop Kies om het dialoogvenster Kies een kleur te openen, waar u de individuele 
kleuren kunt instellen. Zie 'Kleuropties' in hoofdstuk 2 LibreOffice instellen van dit boek.

Voor een meer gedetailleerde beschrijving van kleurenpaletten en hun opties, zie hoofdstuk 10, 
Gevorderde Tekentechnieken, in de Handleiding voor Draw.

Basisvormen tekenen

Draw levert een grote hoeveelheid vormen, geplaatst op paletten, die toegankelijk zijn via de 
werkbalk Tekening. 

Deze alinea beschrijft slechts een aantal van de basisvormen, inclusief tekstvormen, welke in Draw
als objecten worden behandeld. Zie de Handleiding voor Draw voor een complete beschrijving van 
de beschikbare vormen.

Sommige pictogrammen van de werkbalk Tekening wijzigen, afhankelijk van welke vorm van de 
beschikbare vormen geselecteerd is. Pictogrammen met gereedschapspaletten worden 
aangegeven met een klein driehoekje, rechts van het pictogram.

Opmerking
Wanneer u een basisvorm tekent of er één selecteert om te bewerken, zal het veld Info
aan de linkerzijde van de Statusbalk wijzigen om de uitgevoerde actie te reflecteren: 
Maken lijn, Tekstframe xxyy geselecteerd enzovoort. 

Een rechte lijn tekenen

Klik op het pictogram Lijn  op de werkbalk Tekening en plaats de muisaanwijzer daar waar u 
wilt dat de lijn begint. Sleep de muisaanwijzer met de linkermuisknop ingedrukt. Laat de muisknop 
los op het punt waar u wilt dat de lijn moet eindigen. Een handvat voor selectie verschijnt aan elk 
uiteinde van de lijn, wat aangeeft dat dit het huidige geselecteerde object is. Het handvat voor 
selectie aan het beginpunt van de lijn is iets groter dan het andere handvat voor selectie.

Afbeelding 8: Een rechte lijn 
tekenen

Houd de Ctrl-toets ingedrukt terwijl u een lijn tekent, om het einde van de lijn aan het 
dichtstbijzijnde rasterpunt te laten vangen.
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Opmerking
Dit is het standaardgedrag van de Ctrl-toets. Als de optie Vangen aan raster in het 
menu Beeld > Raster echter geselecteerd is, zal de Ctrl-toets  de activiteit Vangen 
aan raster uitschakelen.

Houd de Shift-toets ingedrukt terwijl u de lijn tekent om de hoek van de lijn tot een veelvoud van 
45 graden (0, 45, 90, 135 enzovoort) te begrenzen.

Opmerking
Dit is het standaardgedrag van de Shift-toets. Als echter de optie Tijdens aanmaken of 
verplaatsen van objecten in het gedeelte Vangpositie bij Extra > Opties > LibreOffce 
Draw > Raster geselecteerd is, zal de actie van de Shift-toets het tegenovergestelde 
zijn. Lijnen zullen automatisch met een veelvoud van hoeken van 45 graden worden 
getekend, tenzij de Shift-toets wordt ingedrukt.

Houd de Alt-toets ingedrukt tijdens het tekenen van de lijn om de lijn symmetrisch in beide 
richtingen vanaf het beginpunt uit te breiden. Hierdoor kunt u lijnen tekenen door vanuit het midden
van de lijn te beginnen.

Als een lijn getekend is, gebruikt het de standaard attributen. Om deze attributen te wijzigen 
selecteert u de lijn door er op te klikken, klik dan met rechts en kies Lijn in het contextmenu of ga 
naar Opmaak > Lijn op de Menubalk om het dialoogvenster Lijn te openen (Afbeelding 9). U kunt 

ook op het pictogram Eigenschappen  op de Zijbalk klikken om het gedeelte Lijn te openen. 
Lijnstijl, lijndikte en lijnkleur kunnen ook op de werkbalk Lijn en opvulstijl worden gewijzigd.

Afbeelding 9: Dialoogvenster Lijn
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Een pijl tekenen
Pijlen worden getekend zoals lijnen. Draw classificeert pijlen als een subgroep van lijnen: Lijnen 
met pijlpunten. Ze worden in het veld Informatie op de statusbalk als lijnen weergegeven. Klik op 
het pictogram Lijn met pijluiteinde  op de werkbalk Tekening of het gedeelte Voeg een vorm in
op de Zijbalk om een pijl te tekenen. De pijlpunt wordt aan het uiteinde van de pijl getekend als u 
de muisknop los laat.

Lijnuiteinden kiezen
Verschillende soorten lijnuiteinden (pijlen, cirkels, vierkanten en andere) zijn beschikbaar in Draw. 
Klik op het kleine zwarte driehoekje naast het pictogram Lijnen en pijlen  op de werkbalk 
Tekening of op het gedeelte Voeg een vorm in van het paneel Eigenschappen van de Zijbalk om 
een palet te openen dat gereedschappen bevat om lijnen en pijlen te tekenen. U kunt ook naar 
Beeld > Werkbalken > Pijlen gaan om de werkbalk Pijlen als zwevende werkbalk te openen 
(Afbeelding 10). Het pictogram van het meest gebruikte gereedschap zal op de werkbalk Tekening 
worden getoond, om het makkelijk te maken dezelfde vorm opnieuw te gebruiken.

Na het tekenen van de lijn kunt u de pijlstijl aanpassen, door op het pictogram Pijlstijl  op de 
werkbalk Lijn en opvulstijl te klikken en de start- en eindopties van de pijl te kiezen.

1 Lijn 5 Lijn (45°) 8 Lijn met vierkant/pijl

2 Lijn begint met pijl 6 Lijn eindigt met pijl 9 Maatlijn

3 Lijn met pijl/cirkel 7 Lijn met cirkel/pijl 10 Lijn met 2 pijlen

4 Lijn met pijl/vierkant

Afbeelding 10: Werkbalk Pijlen met beschikbare vormen

Een rechthoek of vierkant tekenen
Rechthoeken tekenen gaat op dezelfde wijze als het tekenen van een rechte lijn. Klik op het 

pictogram Rechthoek  op de werkbalk Tekening of het gedeelte Voeg een vorm in, op het 
paneel Eigenschappen van de Zijbalk. Als u de rechthoek met de muisaanwijzer tekent, bepaalt de
cursor de diagonaal tegenover liggende hoek (dit is afhankelijk van de manier waarop u een 
rechthoek tekent).

Vierkanten zijn rechthoeken met gelijke zijden. Houd de Shift-toets ingedrukt om een vierkant te 
tekenen.

Opmerking
Als de optie Tijdens aanmaken of verplaatsen van objecten in het gedeelte Vangpositie
bij Extra > Opties > LibreOffice Draw > Raster is geselecteerd, is de actie van de 
Shift-toets omgekeerd. Als het gereedschap Rechthoek is geselecteerd, wordt een 
vierkant getekend. Om een rechthoek te tekenen moet de Shift-toets tijdens het 
tekenen ingedrukt worden. Deze omgekeerde werking van de Shift-toets werkt 
hetzelfde bij het tekenen van ellipsen en cirkels.
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Houd de Alt-toets ingedrukt om een rechthoek of een vierkant vanuit zijn middelpunt te tekenen. 
De rechthoek of het vierkant gebruikt het startpunt (waar u als eerste met de muis klikte) als 
middelpunt.

Een cirkel of een ellips tekenen

Gebruik het pictogram Ellips  op de werkbalk Tekening of het gedeelte Voeg een vorm in, in 
het paneel Eigenschappen van de Zijbalk om een ellips of een cirkel te tekenen. Een cirkel is een 
ellips waarvan de twee assen dezelfde lengte hebben. Om een cirkel te tekenen, klik op het 
pictogram Ellips en houd de Shift-toets ingedrukt terwijl u de cirkel tekent.

Houd de Alt-toets ingedrukt om een ellips of een cirkel vanuit zijn middelpunt te tekenen. De ellips 
of de cirkel gebruikt het startpunt (waar u als eerste met de muis klikte) als middelpunt.

Opmerking
Als u eerst de Ctrl-toets indrukt en ingedrukt houdt en dan pas op de pictogrammen 
voor Lijn, Rechthoek, Ellips of Tekst klikt, wordt automatisch een object met een 
standaard afmeting in het werkgebied getekend; de afmeting, vorm en kleur zijn 
allemaal standaardwaarden. Deze attributen kunnen, indien nodig, later gewijzigd 
worden. Bekijk de Handleiding voor Draw voor meer informatie.

Bogen of veelhoeken tekenen

Klik op het pictogram Boog  op de werkbalk Tekening of het gedeelte Voeg een vorm in, in het 
paneel Eigenschappen van de Zijbalk om een boog of een veelhoek te tekenen. Klik op het kleine 
driehoekje naast het pictogram om een vormenpallet met beschikbare bogen en veelhoeken te 
openen (Afbeelding 12). Het gereedschap van de meest recentelijk gebruikte vorm wordt op de 
werkbalk Tekening getoond om het gemakkelijk opnieuw te kunnen gebruiken.

Als u de muiscursor boven één van de pictogrammen beweegt, verschijnt een Helptip met de 
beschrijving van de functie.

Opmerking
De muiscursor over dit pictogram bewegen geeft een Helptip voor Boog. Als u werkbalk
zwevend maakt, wordt de titel Bogen zichtbaar, zoals weergegeven in Afbeelding 11.
Houd de Shift-toets ingedrukt tijdens het tekenen van lijnen, nadat het gereedschap 
van bogen of veelhoeken is ingedrukt, om voor hoeken van 45 of 90 graden te maken.
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1 Vrije-handlijn 4 Veelhoek (45°) 7 Veelhoek, gevuld

2 Boog 5 Vrije-handlijn, gevuld 8 Veelhoek (45°), gevuld

3 Veelhoek 6 Boog, gevuld

Afbeelding 11: Werkbalk Bogen



Bogen
Houd de muisknop ingedrukt om het beginpunt van uw boog te maken, trek dan, met ingedrukte 
linker muisknop, een lijn vanuit het beginpunt. Laat de muisknop los en beweeg de cursor om een 
kromming in de lijn te maken tot er een boog ontstaat. Klik om het eindpunt van de boog vast te 
zetten en de lijn op de pagina vast te zetten. Om uw lijn te vervolgen verplaatst u de cursor om een
rechte lijn te tekenen. Bij elke muisklik zet u een hoekpunt neer en kunt u een volgende rechte lijn 
tekenen vanaf dat hoekpunt. Dubbelklikken beëindigt het tekenen van de lijn.

Een gevulde boog verbindt automatisch het laatste punt met het eerste punt om de figuur te sluiten
en de figuur wordt met de huidige standaard vulkleur opgevuld. Een boog zonder vulling zal na het 
tekenen niet gesloten worden.

Veelhoeken
Teken de eerste lijn vanuit het beginpunt met de linker muisknop ingedrukt. Zodra u de muisknop 
los laat, wordt een eerste hoekpunt getekend. Verplaats de cursor om de tweede lijn te tekenen. Bij
elke muisklik stelt u een hoekpunt in en kunt u een nieuwe lijn tekenen. Een dubbelklik beëindigt 
het tekenen. 

Een gevulde veelhoek verbindt automatisch het laatste punt met het eerste punt om de figuur af te 
sluiten en vult het met de huidige standaard opvulkleur. Een veelhoek zonder vulling zal niet 
worden gesloten aan het einde van de tekening.

Veelhoek 45°
Net als bij gewone veelhoeken worden deze gevormd door lijnen, maar met hoeken van 45 of 90 
graden ertussen.

Vrije-handlijn
Met dit gereedschap kunt u tekenen, net zoals met een potlood. Houd de linkermuisknop ingedrukt
en sleep de muis om de gewenste lijnvorm te tekenen. Het is niet nodig om het tekenen met een 
dubbele klik te beëindigen. Gewoon de muisknop loslaten en het tekenen is voltooid. 

Als u Vrije-handlijn, gevuld hebt geselecteerd, wordt het eindpunt automatisch met het beginpunt 
verbonden en wordt het object gevuld met de toepasselijke kleur.

Tekst toevoegen

Om het gereedschap Tekst te activeren, klik op het pictogram  voor horizontale tekst of op het 

pictogram Verticale tekst  voor verticale tekst. Als het pictogram Verticale tekst niet aanwezig 
is, controleer dan of de optie Aziatisch bij Extra > Opties > Taalinstellingen >Talen geselecteerd
is. U kunt de werkbalk Tekstopmaak activeren (Beeld > Werkbalken) of het gedeelte Teken in het 
paneel Eigenschappen van de Zijbalk gebruiken om het lettertype, tekstgrootte en andere 
teksteigenschappen selecteren, voordat u met typen begint.

Als het gereedschap tekst geactiveerd is, klik op de locatie waar u de tekst wilt plaatsen. Er 
verschijnt een klein tekstframe, die alleen een cursor bevat. Dit frame kan net als elk ander object 
verplaatst worden. Een tekstframe is ook dynamisch en groeit naarmate u meer tekst invoert.

Bekijk het informatieveld in de Statusbalk: het toont dat u tekst invoert en het geeft ook 
gedetailleerde informatie over de huidige locatie van de cursor, met alinea-, rij- en kolomnummers 
(Afbeelding 12).
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Afbeelding 12: Tekstinformatie in de Statusbalk

U kunt een regeleinde invoegen met de toetscombimate Shift+Enter of een nieuwe alinea 
beginnen met de Enter-toets. Bij het invoegen van regeleinden of nieuwe alinea's beëindigt u het 
invoegen van tekst niet en wordt het tekstframe ook niet verlaten. Als u klaar bent met typen, klikt u
ergens buiten het tekstframe om het invoegen of bewerken van tekst te beëindigen.

Teksteigenschappen kunnen ook gedurende de invoer veranderd worden, waarbij elke wijziging 
vanaf de cursorpositie effect heeft. Om de eigenschappen voor alle tekst in het tekstframe te 
wijzigen, moet u alle tekst in het tekstframe markeren.

U kunt opmaakprofielen voor afbeeldingen maken, die u opnieuw kunt gebruiken voor andere 
tekstframes. Selecteer Opmaak > Stijlen en opmaak of druk op F11 om het venster Stijlen en 

opmaak te openen of klik op het pictogram Stijlen en opmaak  op de Zijbalk. 
Afbeeldingsprofielen hebben effect op alle tekst binnen een tekstframe. Om alleen delen van de 
tekst op te maken, gebruikt u directe opmaak op de werkbalk Tekstopmaak of in het gedeelte 
Teken van het paneel Eigenschappen op de Zijbalk.

Tekstframes kunnen ook gevuld worden met kleuren, schaduwen en andere attributen, net als alle 
andere Draw-objecten. U kunt het frame draaien en tekst schrijven onder elke hoek. Deze opties 
worden beschikbaar door met rechts te klikken op het object.

Gebruik het gereedschap Toelichtingen (ook wel tekstballonnen of afbeeldingslabels genoemd), 
geplaatst op de werkbalk Tekening, om toelichtingen te maken.

Als u dubbelklikt op een object, op F2 drukt of op het pictogram Tekst, op de werkbalk Tekening, 
klikt, als een object is geselecteerd, wordt de tekst aan het grafische object toegevoegd. Deze 
tekst wordt onderdeel van het grafische object.

Een grafisch object is niet dynamisch en gedraagt zich niet als een tekstframe. Om de tekst tussen
de kaders van het object te houden, moet u alinea's gebruiken, regeleinden of een kleiner 
tekstformaat gebruiken, de objectgrootte aanpassen of een combinatie van alle vier.

Voor meer over tekst, zie hoofdstuk 2, Basisvormen tekenen en hoofdstuk 10, Geavanceerde 
technieken voor Draw, in de Handleiding voor Draw.

Plakpunten en verbindingen

Plakpunten
Alle Draw-objecten hebben plakpunten, die normaal niet zichtbaar zijn. Plakpunten worden 

zichtbaar als het pictogram Verbinding  op de werkbalk Tekening of in het gedeelte Voeg een
vorm in in het paneel Eigenschappen van de Zijbalk, wordt geselecteerd. De meeste objecten 
hebben vier plakpunten, zoals weergegeven in Afbeelding 13. U kunt meer plakpunten toevoegen 
en plakpunten aanpassen, met behulp van de werkbalk Plakpunten (Afbeelding 14). Ga naar 
Beeld > Werkbalken > Plakpunten om deze werkbalk te openen.
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Afbeelding 13: Vier 
plakpunten

Plakpunten zijn niet hetzelfde als de selectie-handvatten van een object. De handvatten zijn voor 
het verplaatsen of wijzigen van de grootte van een object. Plakpunten worden gebruikt om een 
verbindingslijn aan een object vast te zetten of te plakken zodat, wanneer een object verplaatst 
wordt, de connector met het object verbonden blijft. Bekijk, voor een meer gedetailleerde 
beschrijving van het gebruik van plakpunten, Hoofdstuk 3, Werken met objecten en objectpunten 
en Hoofdstuk 8, Verbindingen, stroomdiagrammen en organisatieschema's van de Handleiding 
voor Draw.

1 Plakpunt invoegen 5 Verdwijnen naar beneden 9 Plakpunt horizontaal rechts uitgelijnd

2 Verdwijnen naar links 6 Plakpuntpositie positief relatief 10 Plakpunt verticaal boven uitgelijnd

3 Verdwijnen naar boven 7 Plakpunt horizontaal links 
uitgelijnd

11 Plakpunt verticaal gecentreerd

4 Verdwijnen naar rechts 8 Plakpunt horizontaal 
gecentreerd

12 Plakpunt verticaal beneden uitgelijnd

Afbeelding 14: Werkbalk Plakpunten

Verbindingen
Verbindingen zijn lijnen en pijlen waarvan de uiteinden automatisch vangen aan plakpunten van 
een object. Verbindingen zijn zeer bruikbaar voor het tekenen van organisatieschema's, 
stroomdiagrammen en gedachtekaarten. Als objecten verplaatst of gerangschikt worden, blijven de
verbindingen automatisch met de plakpunten verbonden. Afbeelding 15 toont een voorbeeld van 
twee objecten met een verbinding.

Draw biedt verscheidene verbindingen en verbindingsfuncties. Op de werkbalk Tekening of in het 
gedeelte Voeg een vorm in in het paneel Eigenschappen van de Zijbalk, klikt u op het driehoekje 
naast het pictogram Verbinding  om de werkbalk Verbindingen te openen (Afbeelding 16). 
Bekijk, voor een meer gedetailleerde beschrijving van het gebruik van verbindingen, Hoofdstuk 8, 
Verbindingen, stroomdiagrammen en organisatieschema's van de Handleiding voor Draw.
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Afbeelding 15: Een verbinding tussen twee objecten

Geometrische vormen tekenen

De pictogrammen voor het tekenen van geometrische vormen bevinden zich op de werkbalk 
Tekening. De geometrische vormen vormen wordt in de volgende secties beschreven. Door op het 
driehoekje rechts van een pictogram op de werkbalk Tekening te klikken opent een zwevende 
werkbalk met geometrische vormen.
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1 Verbinding 11 Directe verbinding met pijlen 21 Gebogen verbinding met 
cirkels

2 Verbinding met pijlbegin 12 Directe verbinding met 
cirkelbegin

22 Lijnverbinding

3 Verbinding met pijluiteinde 13 Directe verbinding met 
cirkeluiteinde

23 Lijnverbinding met pijlbegin

4 Verbinding met pijlen 14 Directe verbinding met cirkels 24 Lijnverbinding met pijluiteinde

5 Verbinding met cirkelbegin 15 Gebogen verbinding 25 Lijnverbinding met pijlen

6 Verbinding met cirkeluiteinde 16 Gebogen verbinding met 
pijlbegin

26 Lijnverbinding met cirkelbegin

7 Verbinding met cirkels 17 Gebogen verbinding met 
pijluiteinde

27 Lijnverbinding met 
cirkeluiteinde

8 Directe verbinding 18 Gebogen verbinding met 
pijlen

28 Lijnverbinding met cirkels

9 Directe verbinding met 
pijlbegin

19 Gebogen verbinding met 
cirkelbegin

10 Directe verbinding met 
pijluiteinde

20 Gebogen verbinding met 
cirkeluiteinde

Afbeelding 16: Werkbalk Verbindingen



Tip
Het gebruik van al deze gereedschappen voor geometrische vormen is vergelijkbaar 
met die van het gereedschap Rechthoek. Voor meer informatie, zie Basisvormen 
tekenen en Hoofdstuk 2, Basisvormen tekenen, in de Handleiding voor Draw.

Opmerking
De pictogrammen voor geometrische vormen op de werkbalk Tekening nemen de vorm
aan van het gereedschap die het laatst voor een object is gebruikt.

Basisvormen

Klik op het driehoekje rechts van het pictogram Basisvormen  om de werkbalk Basisvormen 
te openen. Deze werkbalk bevat ook een driehoek die gelijk is aan die op de werkbalk Tekening.

Afbeelding 17: Werkbalk Basisvormen

Symboolvormen

Klik op het driehoekje rechts van het pictogram Symboolvormen  om de werkbalk 
Symboolvormen te openen.

Afbeelding 18: Werkbalk Symboolvormen

Blokpijlen
Klik op het driehoekje rechts van het pictogram Blokpijlen  om de werkbalk Blokpijlen te 
openen.

Afbeelding 19: Werkbalk Blokpijlen

Stroomdiagrammen

Klik op het driehoekje rechts van het pictogram Stroomdiagrammen  om de werkbalk 
Stroomdiagram te openen. Het maken van stroomdiagrammen, organisatieschema's en 
vergelijkbare planningsgereedschappen worden gedetailleerder beschreven in Hoofdstuk 8, 
Verbindingen, stroomdiagrammen en organisatieschema's, van de Handleiding voor Draw.
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Afbeelding 20: Werkbalk Stroomdiagram

Toelichtingen

Klik op het driehoekje rechts van het pictogram Toelichtingen  om de werkbalk Toelichtingen 
te openen.

Afbeelding 21: 
Werkbalk Toelichtingen

Sterren en banners

Klik op het driehoekje rechts van het pictogram Sterren  om de werkbalk Sterren en banners 
te openen.

Afbeelding 22: Werkbalk Sterren en 
banners

Opmerking
U kunt tekst aan alle geometrische vormen toevoegen. Voor meer informatie, zie 
Hoofdstuk 2, Basisvormen tekenen en Hoofdstuk 11, Gevorderde Draw-technieken, 
van de Handleiding voor Draw.

Objecten selecteren

Directe selectie
De eenvoudigste manier om een object te selecteren is door er op te klikken. Objecten die niet 
gevuld zijn, kunnen geselecteerd worden door op de rand van het object te klikken. Eén klik 
selecteert het; een tweede klik heft de selectie weer op. Om meerdere objecten te selecteren of de
selectie op te heffen, houd de Shift-toets ingedrukt tijdens het klikken.

Selectie door middel van frames
U kunt ook meerdere objecten tegelijk selecteren door er met de muis rondom te slepen. Dit tekent
een rechthoek rondom de objecten en alleen objecten, die volledig binnen deze rechthoek liggen, 
worden geselecteerd.
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Om meerdere objecten te selecteren door middel van frames, moet het pictogram Selecteren  
op de werkbalk Tekening geactiveerd zijn.

Opmerking
Als met de muis wordt gesleept om meerdere objecten te selecteren, wordt de 
selectierechthoek ook wel een selectiekader genoemd.

Verborgen objecten selecteren
Zelfs als objecten achter andere objecten verborgen zijn, kunnen ze nog steeds geselecteerd 
worden. Houd de Alt-toets ingedrukt en klik op een object op de voorgrond, waarachter het 
verborgen object ligt, klik dan opnieuw om het verborgen object te selecteren. Als er meerdere  
objecten zijn, blijf dan de Alt-toets ingedrukt houden en klik net zo lang tot u het object bereikt dat u
wilt hebben. Om in omgekeerde volgorde door te objecten te bewegen, houd de toetscombinatie 
Alt+Shift ingedrukt tijdens het klikken.

Als u op het geselecteerde object klikt, is de rand hiervan vaag door de objecten erboven 
zichtbaar.

Opmerking
De methode met de Alt-toets werkt op computers met de besturingssystemen Windows
en Mac. Op een computer met een Linuxbesturingssysteem moet de methode met de 
Tab-toets, zoals hieronder beschreven, worden gebruikt.

Om een object, dat onder andere objecten is verborgen, met het toetsenbord te selecteren, gebruik
de Tab-toets om door de objecten omlaag te bewegen en stop bij het object dat u wilt selecteren. 
Om in omgekeerde volgorde door de objecten te bewegen, druk op Shift+Tab. Dit is een zeer 
snelle manier om een object te bereiken, maar het zal niet erg praktisch zijn als de tekening een 
groot aantal objecten bevat.

Objecten ordenen

In een complexe tekening kunnen verschillende objecten op elkaar gestapeld zijn. Selecteer het 
object, kies Wijzigen > Schikken op de Menubalk en kies Naar voren of Naar achteren om de 
stapelvolgorde opnieuw te schikken (een object van de voorzijde naar de achterzijde van de stapel
verplaatsen). Of klik met rechts op het object, kies Schikken uit het contextmenu en kies Naar 
voren of Naar achteren. 

De schikkingsopties zijn ook beschikbaar door op het kleine driehoekje rechts naast de knop 

Schikking  van de werkbalk Lijn en opvulstijl te klikken. Dit opent de werkbalk Positie en geeft
toegang tot de verschillende verplaatsingsopties (Afbeelding 23).
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1 Vooraan 4 Achteraan 7 Verwisselen

2 Naar voren 5 Vóór het object

3 Naar achteren 6 Achter het object

Afbeelding 23: Werkbalk Positie

Verplaatsen en objectgrootte aanpassen

Wanneer u een object verplaatst of de grootte wijzigt, controleert u dan het linker gedeelte van de 
statusbalk van Draw (Afbeelding 24). Het gebied links op de Statusbalk toont van links naar rechts:
soort object dat is geselecteerd, de positie van dit object in de tekening in X/Y-coördinaten en de 
afmetingen van het object. De maateenheden zijn degene die gekozen zijn in Extra > Opties > 
LibreOffice Draw > Algemeen.

Voor meer informatie over verplaatsen van objecten en het aanpassen van de grootte, zie 
Hoofdstuk 3, Werken met objecten en objectpunten, in de Handleiding van Draw

Afbeelding 24: Linkerzijde van de Statusbalk bij het verplaatsen of het aanpassen 
van een object

Objecten verplaatsen
Selecteer het object (of een groep objecten) door binnen de randen van het object te klikken en de 
linker muisknop ingedrukt te houden terwijl u de muis versleept, om een object te verplaatsen. 
Tijdens het verplaatsen verschijnt de vorm van het object als een vervaagde versie van de vorm 
om te helpen bij de verplaatsing (Afbeelding 25). Laat de muisknop los om het object op zijn 
nieuwe positie neer te zetten.
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Afbeelding 25: Een object verplaatsen

De grootte van objecten aanpassen
Verplaats één van de handvatten rondom de selectie om de grootte van een object (of een groep 
van geselecteerde objecten) met de muis te wijzigen. De muisaanwijzer verandert van vorm om de
richting aan te geven waarin het selectiehandvat zich beweegt. Als u de grootte van het object 
wijzigt, verschijnt een vage rand om het object (Afbeelding 26). Laat de muisknop los als u de 
gewenste afmeting hebt bereikt.

De resultaten zijn afhankelijk van welk handvat u gebruikt. Gebruik het handvat aan de zijkant om 
de grootte van een object langs één as te wijzigen. Gebruik een handvat in de hoek om de grootte 
langs beide assen te wijzigen.

Afbeelding 26: Afmetingen 
van een object aanpassen

Opmerking
Als u op de Shift-toets drukt bij het aanpassen van de grootte van een object, zal de 
verandering van de grootte symmetrisch worden uitgevoerd ten opzichte van de twee 
assen; zodat de verhoudingen (hoogte/lengte) van het object hetzelfde blijven. Dit 
gedrag van de Shift-toets werkt op alle handvatten.

Dit is het standaardgedrag van de Shift-toets. Als echter Tijdens aanmaken of 
verplaatsen van objecten bij Extra > Opties > LibreOffice Draw > Raster is 
geselecteerd, is de actie van de Shift-toets omgekeerd: dat wil zeggen, de verhouding 
blijven intact tenzij de Shift-toets is ingedrukt.

Draaien en scheeftrekken van een object
Voor meer informatie over draaien en scheeftrekken van een object, zie Hoofdstuk 3, Werken met 
objecten en objectpunten, in de Handleiding voor Draw.

26 | Kennismaken met Draw



Een object draaien
Om een object (of een groep objecten) te draaien, selecteer het object en gebruik één van de 
volgende manieren om te draaien:

• Klik op het pictogram Effecten  op de werkbalk Lijn en opvulstijl.

• Ga naar Beeld > Werkbalken > Modus en selecteer het picogram Draaien .

De selectiehandvatten veranderen van vorm en kleur (Afbeelding 27). Er verschijnt ook een 
draaipunt in het midden van het object. Als u de muiswijzer over de handvatten beweegt verandert 
de cursor van vorm. De handvatten in de hoekpunten zijn voor het draaien van een object en de 
handvatten aan de bovenkant, onderkant en zijkanten zijn voor het scheeftrekken van het object.

Afbeelding 27: Een object draaien

Plaats de muiswijzer boven één van de handvatten in de hoekpunten en het verandert normaal 
gesproken in een boog met pijlpunten aan elk uiteinde. Klik en houd de muisknop ingedrukt en 
begin dan de cursor te bewegen om het object te draaien. Een vervaagde versie van het object, 
dat wordt gedraaid, verschijnt en de huidige hoek van draaiing wordt dynamisch weergegeven in 
de statusbalk.

Opmerking
Het draaien werkt op een iets andere manier voor 3D-objecten, omdat de draaiing 
plaatsvindt in een 3D-ruimte en niet in een vlak. Zie hoofdstuk 7, Werken met 3D-
objecten, in de Handleiding voor Draw, voor meer informatie.

Het draaipunt ligt normaal gesproken midden in het object. Om de plaats van het draaipunt te 
wijzigen, klik met de muis op het object en sleep het object totdat het draaipunt op de gewenste 
positie ten opzichte van het object ligt. U kunt ook het draaipunt zelf verslepen. Dit draaipunt kan 
zelfs buiten het object liggen.

Opmerking
Als u tijdens het draaien van het object de Shift-toets indrukt, zal de draaiing tot 15° 
van de beweging beperkt zijn.

Dit is standaardgedrag van de Shift-toets. Als echter Tijdens aanmaken of 
verplaatsen van objecten bij Extra > Opties > LibreOffice Draw > Raster is 
geselecteerd, is de actie van de Shift-toets omgekeerd: dat wil zeggen, de draaiing is 
beperkt tot 15° van de beweging tenzij de Shift-toets is ingedrukt.
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Een object scheeftrekken
Gebruik de handvatten in het midden aan de bovenzijde, onderzijde of zijkanten van een 
geselecteerd object om een object scheef te trekken. De muisaanwijzer verandert wanneer u deze 
over één van deze handvatten in het midden beweegt. De as, die voor scheeftrekken van een 
object wordt gebruikt, is de zijkant van het object direct tegenover het middelste handvat, dat om 
het object scheef te trekken wordt gebruikt. Deze as blijft vast staan, terwijl de andere zijkanten 
van het object daaraan gerelateerd bewegen, als u met de muiswijzer sleept.

Klik en houd de muisknop ingedrukt en beweeg dan de cursor om het object scheef te trekken. 
Een vervaagde versie van het object, dat wordt scheef getrokken, verschijnt (Afbeelding 28) en de 
huidige hoek van het scheeftrekken verschijnt in de Statusbalk.

Opmerking
Als u tijdens het scheeftrekken van een object de Shift-toets indrukt, zal het 
scheeftrekken tot 15° van de beweging beperkt worden. Dit is standaardgedrag van de 
Shift-toets. Als echter Tijdens aanmaken of verplaatsen van objecten bij Extra > 
Opties > LibreOffice Draw > Raster is geselecteerd, is de actie van de Shift-toets 
omgekeerd: dat wil zeggen, het scheeftrekken is beperkt tot 15° van de beweging tenzij
de Shift-toets is ingedrukt.

Afbeelding 28: Een object 
scheeftrekken

Objecten bewerken

Om een object of de attributen van een object, zoals kleur en dikte van de rand te veranderen, kunt
u gebruik maken van de werkbalk Lijn en opvulstijl, de werkbalk Tekstopmaak, het paneel 
Eigenschappen van de Zijbalk of het contextmenu. Meer informatie over het bewerken van 
objecten en het veranderen van attributen kan worden gevonden in Hoofdstuk 4, Attributen van 
een object wijzigen, in de Handleiding van Draw.

Werkbalk Lijn en opvulstijl
Standaard is de werkbalk Lijn en opvulstijl in Draw aan de bovenzijde van de werkruimte geplaatst.
Als de werkbalk Lijn en opvulstijl echter niet wordt getoond, ga naar Beeld > Werkbalken > Lijn 
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en opvulstijl op de Menubalk om de werkbalk te openen (Afbeelding 29). de meest gebruikte 
attributen kunnen met gebruik van deze werkbalk worden bewerkt. U kunt ook het dialoogvenster 

Lijn openen door op het pictogram Lijn  te klikken en het dialoogvenster Gebied door op het 

pictogram Vlak  te klikken, om toegang tot meer opties te krijgen.

1 Stijlen en opmaak 7 Vlak 13 Spiegelen

2 Lijn 8 Opvulstijl/Vullen 14 Positie en grootte

3 Pijlstijl 9 Opvulkleur 15 Uitlijning

4 Lijnstijl 10 Schaduw 16 Schikken

5 Lijnkleur 11 ImageMap 17 Verdeling

6 Lijndikte 12 Effecten

Afbeelding 29: Werkbalk Lijn en opvulstijl

Werkbalk Tekstopmaak
U kunt de werkbalk Tekstopmaak openen door deze te selecteren bij Beeld > Werkbalken op de 
Menubalk. De gereedschappen op de werkbalken worden pas actief als er tekst geselecteerd is.

1 Lettertype 10 Achtergrondkleur van tekst 19 Regelafstand: 1,5

2 Tekengrootte 11 Links uitlijnen 20 Regelafstand: 2

3 Lettertype vergroten 12 Horizontaal centreren 21 Tekstrichting van links naar rechts

4 Lettertype verkleinen 13 Rechts uitlijnen 22 Tekstrichting van boven naar beneden

5 Vet 14 Uitgevuld 23 Teken

6 Cursief 15 Van links naar rechts 24 Alinea

7 Onderstrepen 16 Van rechts naar links 25 Speciale tekens

8 Schaduw 17 Regelafstand

9 Tekstkleur 18 Regelafstand: 1

Afbeelding 30: Werkbalk Tekstopmaak

Eigenschappen van de Zijbalk
Als u een object in uw tekening selecteert, worden de gedeeltes in het paneel Eigenschappen van 
de Zijbalk actief (Afbeelding 31). Hiermee kunt u de eigenschappen of opties van een object 
aanpassen, zonder een dialoogvenster te hoeven openen of een gereedschap van de 
verschillende werkbalken, die Draw levert, te gebruiken. Om een gedeelte uit te breiden, klik op de 
kleine pijl voor de titel van het gedeelte.

Objecten bewerken | 29



Afbeelding 31: Gedeeltes van het Paneel 
Eigenschappen van de Zijbalk

Het contextmenu
Wanneer een object geselecteerd is, kunt u met de rechter muisknop op het object klikken om een 
contextmenu, dat aan het object gerelateerd is te openen (Afbeelding 32). U kunt attributen van 
een object wijzigen zonder een dialoogvenster te hoeven openen. Menu-items met een kleine pijl 
aan de rechterkant bevatten een submenu.

Afbeelding 32: Voorbeeld van een contextmenu

Lijnen en randen opmaken
De term Lijn duidt in LibreOffice een vrijstaand segment aan (lijn), de buitenrand van een vorm 
(rand) of een pijl. In de meeste gevallen zijn de eigenschappen die aangepast kunnen worden, de 
stijl (doorlopend, gestippeld, onzichtbaar enzovoort), de dikte en de kleur.

Selecteer de lijn die u wilt opmaken en gebruik dan de gereedschappen op de werkbalk Lijn en 
opvulstijl om de meest gebruikte opties te wijzigen (in Afbeelding 33 gemarkeerd).

Afbeelding 33: Veel gebruikte lijneigenschappen (lijnstijl,-dikte en -kleur)
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Als u de weergave van de lijn verder wilt verfijnen, kies Opmaak > Lijn van de Menubalk, klik met 

rechts op de lijn en kies Lijn in het contextmenu of selecteer het pictogram Lijn  op de werkbalk
Lijn en opvulstijl. Al deze methodes openen het dialoogvenster Lijn (Afbeelding 9 op pagina 15), 
waar u de lijneigenschappen kunt instellen. Dit dialoogvenster bestaat uit vier tabbladen: Lijn, 
Schaduw, Lijnstijlen en Pijlstijlen. U kunt ook het gedeelte Lijn in het paneel Eigenschappen van de
Zijbalk gebruiken om de weergave van de lijn aan te passen.

Pijlen, pijlpunten en lijnuiteinden
Pijlen, pijlpunten en andere lijnuiteinden worden gewoonlijk aangeduid als pijlen en kunnen op 
dezelfde manier behandeld worden als lijnen, wanneer de eigenschappen bewerkt en gewijzigd 

worden. Selecteer een lijn en klik op het pictogram Pijlstijl  op de werkbalk Lijn en opvulstijl. 
Dit opent het menu Pijlpunten (Afbeelding 34).

Afbeelding 34: Menu Pijlpunten

Verschillende soorten pijlpunten zijn beschikbaar. Elk uiteinde van de lijn kan een andere pijlpunt 
hebben (of geen pijlpunt). Pijlpunten kunt u alleen op lijnen toepassen. Ze hebben geen effect op 
randen van een object.

De binnenkant (vulling) van een object opmaken
De term in LibreOffice voor de binnenzijde van een object is Vlakvulling. De vlakvulling van een 
object kan een uniforme kleur, een kleurovergang, een arcering of een afbeelding zijn (Afbeelding 
35). Een vulling van een gebied kan gedeeltelijk of geheel transparant worden gemaakt. In de 
meeste gevallen zult u één van de standaard vullingsopties kiezen, welke op de werkbalk Lijn en 
opvulstijl of in het gedeelte Gebied in het paneel Eigenschappen van de Zijbalk, beschikbaar zijn. 
U kunt ook uw eigen vlakvulling maken. Voor meer informatie over het opmaken van een gebied, 
zie Hoofdstuk 4, Objecteigenschappen wijzigen, in de Handleiding voor Draw. 
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Afbeelding 35: Verschillende vullingen van een 
gebied

Opmaakprofielen gebruiken

Stel dat u dezelfde vlakvulling, lijndikte en randen op een verzameling objecten wilt toepassen. Dit 
herhalend proces kan sterk worden vereenvoudigd door het gebruik van opmaakprofielen. 
Opmaakprofielen maken het u mogelijk om een opmaaksjabloon (een groep opmaakprofielen) te 
definiëren en dat vervolgens toe te passen op meerdere objecten. Voor meer informatie over 
opmaakprofielen, zie Hoofdstuk 3, Opmaakprofielen en sjablonen gebruiken, in dit boek, Hoofdstuk
6, Kennismaken met opmaakprofielen, in de Handleiding voor Writer en Hoofdstuk 4, 
Objectattributen wijzigen van de Handleiding voor Draw.

Objecten plaatsen

Functie Vangen aan
In Draw kunnen objecten zeer precies en consistent geplaatst worden met de functie Vangen aan. 
Rasterpunten, vangpunten en lijnen, objectframes, individuele punten op objecten of pagina-
uiteinden kunnen allemaal met de functie Vangen aan worden gebruikt.

De functie Vangen aan kan gemakkelijker gebruikt worden als u zo veel mogelijk inzoomt. Er 
kunnen twee verschillende vangfuncties tegelijk worden gebruikt; bijvoorbeeld, Vangen aan een 
hulplijn en Vangen aan een pagina-einde. Het is echter aan te bevelen om alleen de functies die u 
echt nodig hebt te activeren.

Meer gedetailleerde informatie over de functie Vangen aan vindt u in Hoofdstuk 3, Werken met 
objecten en objectpunten en Hoofdstuk 11, Gevorderde tekentechnieken, van de Handleiding voor 
Draw.

Vangen aan raster
Met Vangen aan raster kunt u een object op een rasterpunt plaatsen (Afbeelding 36). Ga naar 
Beeld > Raster > Vangen aan raster op de Menubalk of klik op het pictogram Vangen aan raster

 op de werkbalk Opties om de functie Vangen aan raster aan te zetten. Als de werkbalk Opties 
niet zichtbaar is, ga naar Beeld > Werkbalken > Opties op de Menubalk.
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Afbeelding 36: Plaatsing met Vangen aan raster

Het raster weergeven
Om het raster in Draw weer te geven of de weergave weer uit te zetten, ga naar Beeld > Raster > 
Raster tonen op de Menubalk of klik op het pictogram Raster tonen  op de werkbalk Opties.

Een raster configureren
De resolutie, vangen en vangpositie van de rasterpunten kunnen ingesteld worden. Ga naar Extra 
> Opties > LibreOffice Draw > Raster op de Menubalk om het dialoogvenster voor het Raster te 
openen (Afbeelding 37).

Afbeelding 37: Het raster instellen

• Verticale en horizontale afstand van de punten in het raster. U kunt ook de maateenheid, 
die in de algemene Draw-opties wordt gebruikt, aanpassen bij Extra > Opties > 
LibreOffice Draw > Algemeen.
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• De resolutie is de afmeting van de vierkantjes of rechthoekjes in het raster. Als de resolutie 
horizontaal 1 cm en verticaal 2 cm is, dan bestaat het raster uit rechthoekjes van 2 cm 
hoog en 1 cm breed.

• Onderverdeling zijn aanvullende punten die langs de zijden van elk rechthoekje of 
vierkantje in het raster verschijnen. Objecten kunnen zowel Vangen aan onderverdelingen 
als aan hoeken van het raster.

• De grootte van de pixels van het vangbereik bepalen hoe dicht u een object bij een 
vangpunt of lijn moet brengen om het er aan te laten vangen.

• De standaardkleur van het raster is lichtgrijs. Om de kleur van de rasterpunten te wijzigen, 
ga naar Extra > Opties > LibreOffice > Vormgeving op de Menubalk.

Hulplijnen
Draw heeft hulplijnen om de positie van een object gemakkelijk te kunnen bepalen, met gebruik 
van de linialen aan de boven- en linkerzijde van de werkruimte. Om de hulplijnen aan of uit te 
zetten, ga naar Extra > Opties > LibreOffice Draw > Weergave op de Menubalk en selecteer de 
optie Vanglijnen bij het verplaatsen of ga naar de werkbalk Opties en klik op het pictogram 
Helplijnen tijdens het verplaatsen .

Speciale effecten toepassen

Met Draw kunt u veel speciale effecten op objecten en groepen van objecten toepassen. Dit 
gedeelte is een introductie van een aantal van deze effecten. Meer informatie over speciale 
effecten, is te vinden in hoofdstuk 4 Attributen van objecten wijzigen van de Handleiding voor 
Draw.

Om de gereedschappen voor speciale effecten te bereiken, ga naar Beeld > Werkbalken > 
Modus (Afbeelding 38). Draaien en Spiegelen kan ook benaderd worden door naar Wijzigen op 
de Menubalk te gaan of door met rechts op een object te klikken en het contextmenu te gebruiken.

1 Draaien 4 Op cirkel zetten (perspectivisch) 7 Transparantie

2 Spiegelen 5 Op cirkel zetten (schuintrekken) 8 Kleurovergang

3 In 3D-rotatieobject 6 Vervormen

Afbeelding 38: Werkbalk Modus

Een object spiegelen
De snelste en eenvoudigste manier om een object horizontaal of verticaal te spiegelen is als volgt:

1) Klik op een grafisch object en de selectie-handvatten verschijnen.

2) Klik met rechts en kies Spiegelen > Verticaal of Horizontaal of ga naar Wijzigen > 
Spiegelen > Verticaal of Horizontaal op de Menubalk en het geselecteerde object zal 
naar de tegenovergestelde richting gespiegeld worden.

Het gereedschap Spiegelen op de werkbalk Modus of de werkbalk Tekenen geeft echter een 
grotere controle over het proces van spiegelen. Met het gereedschap Spiegelen kunt u de positie 
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en de hoek van het spiegelen van een object veranderen en dit wordt beschreven in Hoofdstuk 4, 
Objectattributen wijzigen, in de Handleiding voor Draw.

Een spiegelbeeld maken
Op dit moment is er in Draw geen opdracht om een spiegelbeeld te maken. Het maken van een 
spiegelbeeld van een object kan echter nagebootst worden door het gereedschap Spiegelen te 
gebruiken, zoals wordt beschreven in Hoofdstuk 4, Objectattributen wijzigen, in de Handleiding 
voor Draw.

Vervormen van een afbeelding
Er zijn drie gereedschappen in de werkbalk Modus, die het mogelijk maken de hoeken en randen 
van een object te verslepen om het beeld te vervormen.

Vervormen vervormt een object in perspectief.

Op cirkel zetten (schuintrekken) creëert een pseudo driedimensionaal effect.

Op cirkel zetten (perspectivisch) creëert een pseudo driedimensionaal effect.

In alle drie gevallen wordt u in eerste instantie gevraagd of u het object in een boog wilt 
converteren. Dit is een noodzakelijke eerste stap, klik dus op Ja. Daarna kunt u de handvatten van
het object verplaatsen om het gewenste effect te bereiken. Zie Hoofdstuk 4, Objectattributen 
wijzigen, in de Handleiding voor Draw, voor meer informatie over het vervormen van een object.

Dynamische kleurovergangen
U kunt de transparantie van kleurovergangen en kleurovergangen op dezelfde wijze beheren. 
Beide soorten kleurovergangen kunnen samen worden gebruikt. Met een transparante 
kleurovergang verandert de richting en de mate van opvullen van een object van ondoorzichtig 
naar transparant. In een normale kleurovergang verandert de ene kleur naar de andere, maar de 
mate van transparantie blijft hetzelfde.

De gereedschappen voor Transparantie en Kleurovergang op de werkbalk Modus geven een 
dynamische controle over de transparantie en kleurovergangen. Zie Hoofdstuk 4, Objectattributen 
wijzigen, in de Handleiding voor Draw, voor meer informatie over hoe hoe transparantie en 
kleurovergangen in een object te creëren.

Dupliceren
Dupliceren maakt kopieën van een object en past een aantal wijzigingen, zoals kleur of draaiing, 
toe op de duplicaten.

1) Klik op een object (of op een groep geselecteerde objecten) en kies dan Bewerken > 
Dupliceren of de toetscombinatie Shift+F3, om met dupliceren te beginnen en het 
dialoogvenster Dupliceren te openen (Afbeelding 39).
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Afbeelding 39: Dialoogvenster Dupliceren

2) Kies de gewenste opties uit de beschikbare. Bijvoorbeeld, als de opties in het 
dialoogvenster op een rechthoek worden toegepast, wordt het resultaat als in Afbeelding 
40.

Vormovergang
Vormovergang transformeert een vorm van een object naar een ander en werkt alleen als er twee 
objecten zijn geselecteerd.

1) Selecteer twee objecten met een verschillende vorm.

2) Ga naar Bewerken > Vormovergang op de Menubalk om het dialoogvenster 
Vormovergang te openen (Afbeelding 41).

3) Kies de stapgrootte om het aantal vormen tussen de twee objecten te bepalen.

4) Selecteer Vormgevingsattributen om een geleidelijke aanpassing van de lijn- en 
vullingseigenschappen tussen de twee objecten toe te passen.

5) Selecteer Zelfde oriëntatie om een vloeiende overgang tussen de twee objecten te krijgen.

6) Klik op OK en het resultaat is een nieuwe groep objecten met het eerste geselecteerde 
object als beginobject en het tweede geselecteerde object als eindobject. Bijvoorbeeld, als 
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de twee opties in het dialoogvenster op een vierkant en een driehoek worden toegepast, 
geeft de Vormovergang het resultaat als in Afbeelding 42.

Afbeelding 41: Dialoogvenster Vormovergang

Afbeelding 42: Resultaat van Vormovergang

Het combineren van meerdere objecten

Met behulp van Draw kunt u tekenobjecten met elkaar groeperen of samenvoegen en 
meervoudige objecten als één geheel behandelen of objecten in één nieuwe vorm samenvoegen. 
Meer informatie vindt u in Hoofdstuk 5, Meerdere objecten samenvoegen, van de Handleiding voor
Draw.

Groeperen is zoals het samenbrengen van objecten in een container. U kunt ze als een groep 
verplaatsen en algemene wijzigingen op de objecten in de groep aanbrengen. Een groepering kan 
altijd ongedaan worden gemaakt en de objecten, die de groep vormen, kunnen altijd afzonderlijk 
worden gemanipuleerd. De objecten in de groep behouden ook hun eigen individuele 
eigenschappen.

Een Samenvoeging is een permanente fusie van objecten die leidt tot een nieuw object. De 
oorspronkelijke objecten zijn niet meer als individuele entiteiten beschikbaar en kunnen niet meer 
als individuele objecten worden bewerkt. Elke aanpassing van een samengevoegd object heeft 
invloed op alle objecten die voor de samenvoeging werden gebruikt.

Groeperen

Tijdelijk groeperen
Tijdelijk groeperen is wanneer verschillende objecten geselecteerd werden middels het pictogram 
Selecteren op de werkbalk Tekening of door met de muis een rechthoek rond de objecten te 
trekken (ook wel selectiekader genoemd). Elke wijzing aan objectparameters worden op alle 
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objecten in de tijdelijke groep toepast. Bijvoorbeeld, u kunt een tijdelijke groep objecten in zijn 
geheel draaien.

Om een tijdelijk groep op te heffen, klikt u simpelweg buiten de selectie-handvatten, die rondom de
objecten staan.

Permanent groeperen
Een permanente groep objecten kan gemaakt worden, nadat u de objecten geselecteerd hebt. Ga 
dan naar Wijzigen > Groeperen op de Menubalk gaat of in de selectie met rechts klikt en 
Groeperen in het contextmenu selecteert of de toetscombinatie Ctrl+Shift+G gebruikt. Als u uw 
selectie ongedaan maakt blijven de objecten gegroepeerd.

Als objecten permanent gegroepeerd zijn, wordt elke bewerking op alle leden van de groep 
toegepast. Als u op een lid van de groep klikt, wordt de hele groep geselecteerd.

U kunt een lid van een groepering afzonderlijk bewerken zonder de groep te verbreken. Selecteer 
de groep en ga naar Wijzigen > Groepering betreden, klik met rechts en kies Groepering 
betreden in het contextmenu, gebruik de toets F3 of dubbelklik op de groep.

Als u klaar bent met het bewerken van een afzonderlijk lid van de groepering, ga dan naar 
Wijzigen > Groepering verlaten, klik met rechts en kies Groepering verlaten in het contextmenu
of gebruik de toetscombinatie Shift+F3.

Groepering opheffen
Om een groepering op te heffen of een groep van objecten van elkaar los te maken, selecteer de 
groepering en ga naar Wijzigen > Groepering opheffen op de Menubalk, klik met rechts en kies 
Groepering opheffen in het contextmenu of gebruik de toetscombinatie Ctrl+Alt+Shift+G.

Objecten samenvoegen
Objecten samenvoegen is een permanente samenvoeging van objecten die een nieuw project 
maken. De oorspronkelijke objecten zijn niet meer als individuele entiteiten beschikbaar en kunnen
niet meer als individuele objecten bewerkt worden. Elke bewerking van een samengevoegd object 
heeft invloed op alle objecten die voor de samenvoeging werden gebruikt.

Selecteer een verzameling objecten, en ga naar Wijziging > Samenvoegen op de Menubalk, klik 
met de rechtermuisknop op de objecten en kies Samenvoegen in het contextmenu of gebruik de 
toetscombinatie Ctrl+Shift+K.

Nadat u uw objecten heeft geselecteerd, komen de functies Samenvoegen, Aftrekken en 
Doorsnijden beschikbaar, zodat u nieuwe objecten van uw selectie kunt maken. Zie Hoofdstuk 5, 
Het samenvoegen van meerdere objecten, van de Handleiding voor Draw, voor meer informatie 
over deze functies.

Schikken, uitlijnen en verdelen van objecten 

In Draw kunt u objecten ten opzichte van elkaar schikken, uitlijnen en verdelen:

• De positie van een object wijzigingen door het voorwaarts of achterwaarts te verplaatsen in
de volgorde van de objecten.

• Objecten ten opzichte van elkaar uitlijnen, met behulp van Links, Gecentreerd of Rechts, 
voor horizontale uitlijning, en Boven, Midden of Beneden voor verticale uitlijning.

• De objecten zodanig verdelen, dat de ruimte tussen ieder object gelijk is.

Zie hoofdstuk 5, Het samenvoegen van meerdere objecten, in de Handleiding voor Draw voor 
meer informatie over het ten opzichte van elkaar schikken en uitlijnen van objecten.
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Invoegen en bewerken van foto's

Draw bevat een aantal functies voor het bewerken van rasterafbeeldingen (bitmaps) – bijvoorbeeld
foto's en gescande afbeeldingen. Dit omvat ook het importeren en exporteren van afbeeldingen 
alsmede omzetting van het ene formaat naar het andere.

Draw biedt een groot aantal grafische filters, zodat het verschillende grafische bestandsformaten 
kan lezen en weergeven. Het bevat ook verschillende gereedschappen voor het werken met 
rasterafbeeldingen, maar het heeft niet dezelfde functionaliteiten als gespecialiseerde grafische 
programma's, zoals Gimp of Adobe Photoshop. Zie Hoofdstuk 6, Afbeeldingen bewerken, van de 
Handleiding voor Draw, voor meer informatie.

U kunt foto's uit verschillende bronnen invoegen:

• Rechtstreeks vanaf een scanner (Invoegen > Afbeelding > Scannen).

• Foto's gemaakt door een ander programma, inclusief foto's van een digitale camera 
(Invoegen > Afbeelding > Uit bestand).

• De Galerij van Draw - zie hoofdstuk 11, Afbeeldingen, de Galerij en Fontwork, in dit boek 
voor meer informatie.

Werken met 3D-objecten

Hoewel Draw niet dezelfde functionaliteiten heeft als de toonaangevende teken- of 
fotobewerkingsprogramma's, is het in staat om zeer goede 3D-tekeningen te produceren en te 
bewerken.

Draw biedt twee soorten 3D-objecten aan: 3D-lichamen, en 3D-vormen. Afhankelijk van welk type 
u kiest, zijn er verschillende mogelijkheden voor verdere bewerking van het object (rotatie, 
belichting, perspectief enzovoort). 3D-vormen zijn eenvoudiger in te stellen en te bewerken, maar 
3D-lichamen kunnen meer aangepast worden.

Zie hoofdstuk 7, Werken met 3D-objecten, in de Handleiding voor Draw, voor details.

Afbeeldingen exporteren

Draw slaat afbeeldingen en tekeningen op in het open source formaat *.odg. Gebruik Bestand > 
Exporteren en kies een formaat uit de keuzelijst om een afbeelding of het gehele bestand in een 
andere indeling op te slaan. Draw kan bestanden in veel verschillende grafische bestandsformaten
opslaan, zoals vermeld in Appendix B, Open source, Open standaarden, Open document, van dit 
boek.

U kunt Draw-bestanden ook exporteren naar HTML, XHTML, PDF of Flash. PDF-export is 
hetzelfde als voor andere delen in LibreOffice, zoals beschreven in Hoofdstuk 10 Afdrukken, e-
mailen en exporteren van dit boek.

HTML-export maakt gebruik van een conversie assistent die evenveel webpagina's maakt als er 
pagina's in uw Draw document zijn. U kunt er desgewenst voor kiezen om de pagina's in frames 
met een navigator weer te geven en een index pagina aan te maken. Voor meer informatie, zie 
hoofdstuk 12, Webpagina's maken, van dit boek. 

Notities aan een tekening toevoegen

U kunt notities in uw tekening toevoegen en dit werkt hetzelfde als in Writer en Calc.
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1) Kies Invoegen > Notitie op de Menubalk. Een klein vakje, met daarin uw initialen, 
verschijnt in de linker bovenhoek van uw tekening, met een groter tekstvak ernaast 
(Afbeelding 43). Draw heeft automatisch uw naam en de datum aan de onderzijde van dit 
tekstvak toegevoegd.

2) Typ of plak uw notitie in het tekstvak. Optioneel kunt u enige basale opmaak toepassen op 
de delen van de tekst door deze te selecteren, met rechts te klikken en te kiezen uit het 
contextmenu. Vanuit dit menu kunt u de huidige notitie, alle notities van dezelfde auteur of 
alle notities in het document verwijderen.

3) U kunt de kleine markeringen van de notitie op de tekening verplaatsen waarheen u  wilt. 
Gewoonlijk zult u het op of nabij een object plaatsen waarnaar u verwijst in de notitie.

4) Kies Beeld > Notities op de Menubalk om de markeringen van de notities weer te geven of
te verbergen.

U kunt naar Extra > Opties > Gebruikersgegevens gaan, om de naam in te voeren die u in het 
veld Auteur van de notitie wilt laten verschijnen.

Als meer dan één persoon het document bewerkt, krijgt elke auteur automatisch een andere 
achtergrondkleur toegewezen.
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